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Release User Group Agenda

May 2, 2023 10:00 a.m.—11:00 a.m. (Pacific Time)
Web Conference Information Conference Call Information
Web Address:

https://caiso.webex.com/caiso/i.php?MTID=m8f4dee2c?
059898b3609c46be3cd2c20

1-844-621-3956 United States Toll Free

Audio connection instructions will be available after +1-650-479-3208 United States Toll

connecting to the web conference. When prompted, Meeting number (access code): 2491 042 7352
select "Call me" and enter the phone number you will use
during the call. You will be called by the conference
shortly.

Calls and webinars are recorded for stakeholder convenience, allowing those who are unable to attend to listen to the
recordings after the meetings. The recordings will be publicly available on the ISO web page for a limited time
following the meetings. The recordings, and any related transcriptions, should not be reprinted without the ISO’s
permission.

https://www.caiso.com/informed/Pages/MeetingsEvents/UserGroupsRecurringMeetings/Default.aspx#RUG

http://www.caiso.com/informed/Pages/ReleasePlanning/Default.aspx
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https://caiso.webex.com/caiso/j.php?MTID=m8f4dee2c7059898b3609c46be3cd2c20
https://www.caiso.com/informed/Pages/MeetingsEvents/UserGroupsRecurringMeetings/Default.aspx#RUG
http://www.caiso.com/informed/Pages/ReleasePlanning/Default.aspx

ISO Training Schedule

Training Course Date and time

ISO Workshop: Introduction to ISO Markets August 8 and 9
9am — 12pm PPT

ISO Workshop: Market Transactions August 15 and 16
9am — 12pm PPT

ISO Workshop: ISO Settlements August 22 and 23
9am — 12pm PPT

Questions for the upcoming release training? Submit questions here -
https://www.surveymonkey.com/r/CAISOreleasetrainingguestions

Are you looking for more training?

The ISO Learning Center has computer based training available for lots of topics. Check out the
Learning Center: http://www.caiso.com/participate/Pages/LearningCenter/default.aspx

“31 California ISO ISO PUBLIC CustomerReadiness@caiso.com
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http://www.caiso.com/participate/Pages/LearningCenter/default.aspx
https://www.surveymonkey.com/r/CAISOreleasetrainingquestions

Release Plan Summary

Summer 2023 Release
Energy Storage Enhancements Track 1
WEIM Resource Sufficiency Evaluation Enhancements Phase 2 Track 1
Hybrid Resources Phase 2C — Settlements
Ancillary Service State of Charge Constraint

Fall 2023 Release
Energy Storage Enhancements Track 2
WEIM Resource Sufficiency Evaluation Enhancements Phase 2 Track 2
WEIM Resource Sufficiency Evaluation Enhancements Phase 2 Track 3
Washington WEIM Greenhouse Gas Enhancements & Interim Solution for April 2023

Independent 2023 Releases
WEIM Enhancements: ETSR Ul; May 2023
WEIM Enhancements: Shared Ramping Constraint
Hybrid Resources Phase 2C — RIMS
Application Delivery Resiliency

Future Release — Tentative, under further assessment
Transmission Service & Market Scheduling Priorities Phase 2
Day-Ahead Market Enhancements
Extended Day-Ahead Market
Congestion Revenue Rights System Upgrade
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Summer 2023 Release
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Summer 2023 Release Overview

Market

Project BOG Tariff BRS Settlements CG Settlt‘ements TE?l"InIC-a I Simulation 'Markt?t Pro¢‘:|uct.|on
Effective Date| Specifications . Simulation Activation
Scenarios
e Draft 02/10/23 NA
E:Erag:c:::gt: Approved ¢ Revised DTL . gzgggg NA (Settlements isin | (Settlements NA NA Start May 1, 06/01/23
Track 1 12/14/22 03/15/23 14 Track 2 Fall 2023) isin Track 2 2023
e Filed 03/31/23 ' Fall 2023)
e Revised
WEIM Resource 12/12/22 03/30/23
Sufficiency e Final Revised DTL| + 02/10/23 1st of the OASIS 7.3.0
Evaluation ?27{2\/’;; 03/07/23 |+ 03/31/23 month; new 04/07/23 Sta’; :;':V L1 oe/01/23
Enhancements e Revised Final DTL 1.1 CCs 04/03/23 CMRI
Phase 2 Track 1 03/21/23 6.3.0
e Filed 03/31/23
e 02/17/23: Tech Doc
e 03/15/23: 1st Draft
brid CG
Hybrid Resources e 04/05/23: 2" DCG
: 1st of the Start May 1,
Settlements *  05/24/23: Pre-Prod
file & Final Artifacts
e 05/31/23: Deploy
Ancillary Service Filed 09/19/22 Retroactive to|04/03/23 CMRI Start May 1
Stactsn‘;ftg;::ge Accepted 11/18/22 | 0%/09/23 09/20/22 6.3.0 NA 2023 06/01/23
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Summer 2023 Release Overview — System Impacts

Charge Constraint

Pending Data
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Overview — System Interface Changes — Summer 2023 Release

System| Project ul API Data Tech Specs| MAPSTAGE
No new data publication on 2 RetrieveEIMTestResults
reports: RretrieveEIMTestResults_DocAttach The historical pre-activation data shall still be available via
the Ul & APIl. New data won’t be published for these.
CMRI RSEE2T1 |EIM > Bid Range Capacity Test  [These will not populate new data for 4/3/23 4/18/23
Results EIMBidRangeCapacityTest and [These data are moved to OASIS reports below (WEIM RSE
EIM > Flexible Ramp Requirement|EIMFlexibleRampRequirementSufficiencyTest Capacity Tests, FRR Inputs & Outputs)
Sufficiency Test Results sections
New:
New: Real-Time > Market Active [RetrieveMarketActiveResourceConstraintvl Deployed
CMRI Assocc Resource Constraint RetrieveMarketActiveResourceConstraintvl_DocA Data retroactive to 9/20/22 4/3/23 4/26/.23
Pending Data
ttach
: ic Bids > Bi
OASIS | RSEE2T1 2‘:;: Public Bids > Market Bid |y v MKT_BID_CAPS_GRP 3/30/23 |4/18/23
> Original data publishing is existing system functionality.
> Corrected data publishing is new system functionality
that will be published on same existing report as original
Existing: Energy > EIM > WEIM e . data.
OASIS | RSEE2T1 RSE Capacity Tests Existing: Energy > EIM > WEIM RSE Capacity Tests BAA RSE Capacity Test Failure Upward/Downward 4/12/23 |4/18/23
Capacity (15-min granularity)
>New Column in CSV
>New DATA_ITEM in XSD
> Original data publishing is existing system functionality.
Existing: Energy > Flexible > Corrg'ected dataf publishing is nevy system functlon?h‘ty
. : - . . ) that will be published on same existing report as original
Ramping > Flexible Ramp Existing: Energy > Flexible Ramping > Flexible data 1/12/23
OASIS | RSEE2T1 |Requirements Inputs and Outputs|Ramp Requirements Inputs and Outputs (WEIM . . . 4/18/23
R . . . >BAA RSE Flexible Ramp Test Failure Upward/Downward
(WEIM RSE Flexible Ramping RSE Flexible Ramping Tests) . . .
Capacity (15-min granularity)
Tests) .
- >New Column in CSV
& Cdlifornia ISO ISO PUBLIC [>New DATA_ITEM in XSD
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Overview — System Interface Changes — Summer 2023 Release

System | Project ul API Data Tech Specs MAPSTAGE
BAA Assistance Energy NA — NA —
CIDI | RSEE2T1 [Transfer Opt In/Out NA NA Production Production
Checkbox 4/10/23 4/10/23
MF | RSEE2T1 [Existing Existing BAA Assistance Energy Transfer Opt In/Out Flag NA 4/17/23
SIBR ESET1 [Existing Existing Rules Only NA 4/17/23
SIBR | RSEE2T1|NA NA Send RTM Bid Cap data downstream NA 4/17/23

Exports e-Tagging Submission Requirement
> SCs shall be required to e-tag the following as “Firm Provisional Energy (G-
FP)”, via utilizing Misc. field:
o RTeconomic (RTECON) exports that clear HASP
o DA economic (DAECON) exports that clear both RUC and HASP
o RTLPT exports that clear HASP
o DALPT exports that clear both RUC and HASP
> SCs shall be required to e-tag the following as “Firm Energy (G-F)”:
o RTPT exports that clear HASP
o DAPT exports that clear both RUC and HASP

ITS RSEE2T1|Existing NA NA NA
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Summer 2023 Release Market Simulation Communication

May

Tuesday Wednesday Thursday

1 2* 3 4* 5
8 9* 10 11~ 12
15 16* 17 18* 19
22 23* 24 25* 26

Market

Simulation
Forum

*Settlements
Trade Date
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Summer 2023 — Energy Storage Enhancements Track 1

This initiative evolves processes and systems to help storage resource scheduling coordinators better manage resource
state of charge and continue to ensure efficient market outcomes. The purpose of this initiative is to enhance reliability
High Level Business tools with regards to storage resources. The enhancements include updates to bidding rules, exceptional dispatch of
Problem or Need storage resources, and storage resource opportunity costs. The scope of Track 1 covers the enhancements slated for
Summer 2023 Release. The remaining scope in the Energy Storage Enhancements Policy will be covered in Track 2 for
Fall 2023 Release.

Reliability Enhancements

* Include expected impacts from regulation in State of Charge (SOC)

» Require storage to bid energy in the opposite direction of Ancillary Service (AS) awards
High Level Project » A resource providing reserves, regulation up, or regulation down must have energy bids to charge/discharge
Scope (respectively)

* Energy bids must be 50% of AS awards
Reference Level Enhancements
» Update DA storage resource default energy bid (DEB) to include storage specific opportunity cost

BPM Changes Market Instruments, Market Operations

Impacted Systems SIBR, Market

&> California ISO ISO PUBLIC
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Summer 2023 — Energy Storage Enhancements Track 1

High Level Changes

SIBR New rules to require storage resources to bid energy in the RT market in the opposite direction of their DAAS
awards (applies to all AS awards—spin/non-spin, regulation up, and regulation down)

Market + Update state of charge (SOC) to include Regulation Up and Regulation Down awards (includes multipliers)
* Update storage resource DA DEB to include Opportunity Cost

& California ISO ISO PUBLIC



Summer 2023 — Energy Storage Enhancements Track 1

Milestone Type Milestone Name

Board Approval

External BRS

Settlements
Config Guides

Tech Spec

Tariff

Training

Market Sim

Production Activation

&> California 1ISO

Obtain Board of Governors Approval
WEIM Governing Board Approval

Post External BRS
Post External BRS 1.4

NA (Settlements is in Track 2 Fall 2023)

NA

Draft Tariff Language

Revised Draft Tariff Language
File Tariff

FERC Response

Training

Market Sim

Energy Storage Enhancements Track 1

ISO PUBLIC

Dec 14, 2022

Feb 08, 2023
Mar 29, 2023

NA

NA

Feb 10, 2023
Mar 15, 2023
Mar 31, 2023
May 31, 2023

May 02, 2023

Start May 1, 2023

Jun 01, 2023

ANRN

AN




Summer 2023 — WEIM Resource Sufficiency Evaluation Enhancements
Phase 2 Track 1

Project Information

+ Track-1
* Item1A — Count hourly Exclude RTLPT exports and RT economic (RTECON) exports in RSE Capacity
Upward/Downward Test and Flexible Ramping Sufficiency Upward/Downward Test for CAISO BAA.
* Item1B — Facilitate assistance energy transfer between WEIM BAAs into the WEIM BAAs that failed
RSE upward test:
High Level Project » Added as ex-post surcharge through Settlements.
Scope » Market broadcasts needed data to Settlements.
* Item1C — Clarification of Post-HASP Block Hour Low-Priority Export
* Require DALPT and DA economic (DAECON) export that clears both RUC and HASP, RTLPT
and RT economic (RTECON) export that clears HASP be e-tagged as “Firm Provisional Energy
(G-FP)” via utilizing existing Market Path Product and Misc Info fields.

BPM Changes Western Energy Imbalance Market, Market Operations, Settlements and Billing

Tariff Changes Sections 29.11, 29.34

Impacted Systems MF, Market, Settlements, OASIS, CMRI

&> California ISO ISO PUBLIC



Summer 2023 — WEIM Resource Sufficiency Evaluation Enhancements
Phase 2 Track 1

High Level Changes

MF » Define Assistance Energy Transfer Opt In/Out flag for each WEIM BAA receipt of assistance energy transfer
» Make BAA Assistance Energy Transfer Opt In/Out Flag accessible to downstream systems.
Market » Exclude RTLPT Exports and RTECON Exports Associated with Latest RTPD Run from RSE Tests for

CAISO BAA Only
* Opted-Out / Opted-Inn Assistance Energy Transfer

Settlements + Calculate RT Assistance Energy Transfer Ex-Post Surcharge for Insufficient WEIM BAAs.
» Allocate Collected RT Assistance Energy Transfer Ex-Post Surcharge Revenue from Insufficient WEIM
BAAs to all other WEIM BAAs that Pass Upward RSE Tests Pro Rata to their Net Exports.
» BAA Sub-Allocation of Charged Assistance Energy Transfer Ex-Post Surcharge Cost to Measured Demand
for CISO BAA.
« WEIM Entities sub allocation of the charged assistance energy transfer ex-post surcharge cost will be
performed per their defined OATT of these WEIM Entities (outside CAISO’s Settlements system).
» BAA Sub-Allocation of Received Assistance Energy Transfer Ex-Post Surcharge Revenue to SCs Providing
Incremental RT Imbalance Energy for CISO BAA.
+ WEIM Entities sub allocation of the received assistance energy transfer ex-post surcharge revenue
will be performed per their defined OATT of these WEIM Entities (outside CAISO’s Settlements
system).

OASIS « Consume RTM Bid Cap from SIBR.
* Consume corrected RSE Failure Capacities
* Publish RTM Bid Cap.
* Publish corrected values of RSE Failure Capacities.

CMRI Retire publication of new data in the following reports; new data will be available in OASIS
+ EIM > Bid Range Capacity Test Results
+ EIM > Flexible Ramp Requirement Sufficiency Test Results

K I NN ATTIVL LI VN - ———




Summer 2023 — WEIM Resource Sufficiency Evaluation
Enhancements Phase 2 Track 1

Milesione Type ___ Wilesione Name

Obtain Board of Governors Approval

EEE) AEATOVE WEIM Governing Board Approval Dec 14, 2022 v
External BRS Post External BRS Mar 10, 2023 v
Post External BRS v1.1 Mar 31, 2023 v
First Draft Technical Documents Feb 17, 2023 v
First Draft Configuration Output File + Draft Release Artifacts Mar 15, 2023 v
Settlements Second Draft Configuration Output File (Remove ESET1) Apr 05, 2023 v
Config Guides Third Draft Configuration Output File Apr 27, 2023
Pre-Production Configuration Output File + Final Release Artifacts May 24, 2023
Production Deployment May 31, 2023
Tech Spec Create ISO Interface Spec (Tech spec) — OASIS 7.3.0 Mar 30, 2023 v
Create ISO Interface Spec (Tech spec) — CMRI 6.3.0 Apr 03, 2023 v
Revised Tariff Dec 12, 2022 v
Final Revised Draft Tariff Language Mar 07, 2023 v
Tariff Revised Final Draft Tariff Language Mar 21, 2023 v
File Tariff Mar 31, 2023 v
FERC Response May 31, 2023
Draft BPM changes — WEIM Mar 30, 2023 v
BPMs Draft BPM changes — Market Instruments Apr 03, 2023 v
Draft BPM changes — Market Operations Mar 30, 2023 v
Draft BPM changes — Settlements & Billing Mar 29, 2023 v
Training Training Course Apr 26, 2023 v
METLEEE 1 Market Sim Scenarios Apr 07, 2023 v
Scenarios
Market Sim Market Sim Start May 1, 2023 v
Pro.duc.tlon Resource Sufficiency Evaluation Enhancements Phase 2 Track 1 Jun 01, 2023
Activation

‘\3 California ISO ISO PUBLIC




Summer 2023 — Hybrid Resources 2C Settlements

The ISO launched this stakeholder initiative to identify new or enhanced market rules and business processes
needed to accommodate hybrid resources, resources that consist of two sets of market rule changes that will
facilitate mixed-fuel type (hybrid and co-located resources) project participation in the ISO markets.

High Level Prior to this initiative, Phase 1 identified a first set of modifications generally concerned with setting up and
Business Problem operating co-located resources.
or Need

Building on phase 1, Phase 2 focuses on modifications that will explore how hybrid generation resources can be
registered and configured to operate within the ISO market. The initiative will further develop solutions allowing
developers to maximize the benefits of their resource’s configuration. Additionally, hybrid resource configurations
also raise new operational and forecasting challenges that the ISO plans to address during this initiative.

With this initiative, there’s an opportunity to increase storage and the number of hybrid resources that can connect
to the ISO grid. Currently the interconnection queue includes more than 24,000 MW of mixed fuel projects and
nearly 20,000 MW of storage which represents roughly half of all generation in the current interconnection queue.

High Level Project
Scope

BPM Changes Settlements & Billing

Summer 2023: Settlements
Impacted Systems Independent 2023: RIMS
Completed: Today’s Outlook, ISO Today Mobile Application, Reports

Requirements http://www.caiso.com/Documents/BusinessRequirementsSpecifications-HybridResourcesPhase?2.pdf

&> California ISO ISO PUBLIC
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Summer 2023 — Hybrid Resources 2C Settlements

Milestone Type | Milestone Name

External BRS Publish External BRS Jan 31, 2023
First Draft Technical Documents Feb 17, 2023 v
First Draft Configuration Output File + Draft Release Artifacts Mar 15, 2023 v
Settlements Second Draft Configuration Output File (Remove ESET1) Apr 05, 2023 v
Config Guides Third Draft Configuration Output File Apr 27, 2023 v
Pre-Production Configuration Output File + Final Release Artifacts May 24, 2023
Production Deployment May 31, 2023
Tech Spec Create and Publish 1SO Interface Spec (Tech Specs) NA
BPMs Draft BPM changes — Settlements & Billing Mar 31, 2023 v
Training Communication (no Training course) May 2023
Market Sim Market Sim Window — Settlements Start May 01, 2023 v
Pro_duc_tlon Hybrid Resources 2C — Settlements Jun 01, 2023
Activation
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Summer 2023 — Ancillary Services State of Charge Constraint

Project Information Details/Date

In spring of 2022, the Department of Market Monitoring (DMM) discovered undue market outcomes resulting from

High Level : o . : e
Business Problem regulation down awards to or self-provisions by storage resources for long periods when paired with high energy
or Need bids from those resources. Both DMM and the CAISO have concluded that these excess bid cost recovery

payments under these conditions cannot be justified by the principles underlying bid cost recovery.

Make storage resources ineligible for Bid Cost Recovery (BCR) uplift for certain market intervals in real time:

High Level Project * When the market state of charge (SOC) constraint is binding due to AS Awards causing the market to dispatch
Scope resource energy uneconomically.

» Retroactively settle relevant intervals (beginning with effective date of 09/20/2022)

BPM Changes Market Instruments, Market Operations, Settlements and Billing

Sections 8.4.3,8.4.1.1(g), 11.6.6

WL CTEEEE Note: Tariff filing completed on 09/19/2022

Impacted Systems RTM, Settlements, CMRI

Real Time Markets Capture RTD/RTPD AS SOC binding constraint shadow price data

(RTM)
Settlements Design new bill determinants and configurations using the RTD/RTPD AS SOC binding constraint shadow price
data for calculation of BCR ineligibility
CAISO Market Develop new external report to inform on AS SOC binding constraint for settlement purposes (resource specific—
Results Interface private report)
(CMRI)
&> California ISO ISO PUBLIC




Summer 2023 — Ancillary Services State of Charge Constraint

Milestone Type | Milestone Name

External BRS Publish External BRS Feb 09, 2023
First Draft Technical Documents Feb 17, 2023 v
First Draft Configuration Output File + Draft Release Artifacts Mar 15, 2023 v
Settlements Second Draft Configuration Output File (Remove ESET1) Apr 05, 2023 v
Config Guides Third Draft Configuration Output File Apr 27, 2023 v
Pre-Production Configuration Output File + Final Release Artifacts May 24, 2023
Production Deployment May 31, 2023
Tech Spec Create and Publish I1SO Interface Spec (Tech Specs) — CMRI 6.3.0 Apr 03, 2023 v
Tariff File Tariff ER22-2881 Sep 19, 2022 v
Tariff Accepted Nov 18, 2022 v
Training Training Course May 01, 2023 v
Market Sim Market Sim Start May 01, 2023 v
Market Sim — CMRI Data in New Market Active Constraint Report Week of May 08, 2023
: Ancillary Service State of Charge Constraint — Activation Jun 01, 2023
Production

Ancillary Service State of Charge Constraint — Effective Date Retroactive  Sep 20, 2022

&> California 1ISO 1S PUBLIC




Future — Ancillary Services State of Charge Constraint Review

« Postponed: Ancillary Service State of Charge Constraint, straw
proposal, hybrid meeting on 4/27/23

« The California ISO has postponed the April 27, 2023 stakeholder
meeting on the Ancillary Service State of Charge Constraint
(ASSOCC) until the third quarter of 2023 and a notice will be sent
once this meeting is rescheduled. The straw proposal comment
deadline of May 11 will also be rescheduled.

 The ISO is committed to a stakeholder process to explore
compensation when storage resources are subject to the ancillary
service state of charge constraint.

« Additional information related to the initiative is available on Ancillary
Service State of Charge Constraint webpage.

“3 California ISO ISO PUBLIC




Fall 2023 Release
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Fall 2023 Release Overview

. . Settlem.ents Technical .Marke:t Market Production
Project BOG Tariff BRS Settlements CG | Effective g s Simulation . . L
Specifications R Simulation Activation
Date Scenarios
Energy Storage * Draft O 2/10/23 1st of the ADS
Approved e Revised DTL  02/17/23:
Enhancements Yes month; new CMRI Yes Yes Fall 2023
Track 2 12/14/22 03/15/23 Tech Doc Ce OASIS
* Filed 03/31/23
WEIM Resource
Sufficiency « 02/10/23
. Approved
Evaluation Yes e 03/31/23 NA NA MFRDT Yes Yes Fall 2023
12/14/22
Enhancements 1.1
Phase 2 Track 2
WEIM Resource
Sufficiency Apbroved « 02/10/23
Evaluation PP NA . 03/31/23 NA NA ALFS Yes Yes Fall 2023
12/14/22
Enhancements 1.1
Phase 2 Track 3
Filed 11/21/22
Washington Accepted 02/10/23
WEIM Oct 2022 - | Filed Amendment MFRDT
Greenhouse Gas| Approved 03/13/23 02/06/23 NA NA OASIS NA NA Fall 2023
Enhancements Amendment
Accepted 04/20/23
&> California ISO SO PUBLIC

e



Fall 2023 Release Overview — System Impacts

Q
a = = S =
Q| = o | 2 «n | S
8 5135 pn 82w 2 2% 5 B
< < | o | O | El2El 2| 0l 2glne 2| &
Energy Storage * * *
Enhancements Track 2 X X X X X X X
WEIM Resource
Sufficiency Evaluation N
Enhancements Phase 2 S S S S S
Track 2
WEIM Resource
Sufficiency Evaluation
X* X X X
Enhancements Phase 2
Track 3
WA WEIM GHG X X x* | x* X X X
Enhancements
X* = Technical Specifications
&> California 1ISO ISO PUBLIC
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Fall 2023 Release Overview — System Interface Changes

System Project Ul API Data Tech Specs
ADS* ESET2 Existing Existing New EI?' Reason Codes: “SOC Hold” and “SOC Ves
Charge
New report to display SN;\:;: (I:férr:z\:eeEccl:eptlonal Dispatch Hold
CMRI* ESET2 Exceptional Dispatch Hold . 8 . . Yes
State of Charge New: Retrieve Exceptional Dispatch Hold
& State of Charge v1 DocAttach
Existing: Energy > System > . -, Lu ” “
OASIS* ESET2 Operator-Initiated Ex1st|ng. System > Operator-Initiated New EI?’type Reason Code: “SOC Hold” and “SOC Ves
. Commitment report Charge
Commitment report
Add a new Resource-Specific - .
MF RDT* RSEE2T2 Capacity Test Failed-to-Start [ 00 8 €W Resource-Specific Capacity Test Ves
. Failed-to-Start Rule Exemption flag
Rule Exemption flag
<ting: Existing >
E:Lss;nf EZXL:iS;Irr;gentApp & > Pull storage resource MWh from MF
RIMS ESET2 Configuration tab > NA > Add new f!dd for calculated MWh Lo NA
. > Add new field for storage resource duration in
Generation as Modeled and hours
Implemented grid
Exports e-Tagging Submission Requirement
> SCs shall be required to e-tag the following as
“Firm Provisional Energy (G-FP)”, via utilizing Misc.
field:
o RT economic (RTECON) exports that clear
HASP
L o DA economic (DAECON) exports that clear
ITS RSEE2T2 Existing NA both RUC and HASP NA
0 RTLPT exports that clear HASP
o DALPT exports that clear both RUC and HASP|
> SCs shall be required to e-tag the following as
“Firm Energy (G-F)”:
o RTPT exports that clear HASP
o DAPT exports that clear both RUC and HASP

https://developer.caiso.com

&> California ISO SO PUBLIC

.


https://developer.caiso.com/

Fall 2023 Release Overview — System Interface Changes

Technical

System | Project ul API pate Specifications

New Attributes/Records to indicate

WA WEIM |_ . . _— ) . .
CMRI* GHGE Existing Existing state/include GHG index price for each Yes
state
OASIS* WA WEIM |Existing: Prices > Index Prices > Existing — Prices > Index Prices > Add WA GHG index prices, display average Ves

GHGE |Greenhouse Gas Allowance Index Prices  |Greenhouse Gas Allowance Index Prices  |of daily WA GHG price indices

SubmitGeneratorRDT_MFRDv5

SubmitGeneratorRDT_MFRDv5_DocAttach

WA WEIM |Add a new BAA level attribute to identify Add a new BAA level attribute to identify

MF RDT* . . . RetrieveGeneratorRDT_MFRDv5 . . . Yes
GHGE |[BAAs associated with Washington State RetrieveGeneratorRDT_MFRDVS_DocAttac BAAs associated with Washington State
h
WA WEIM |_ . . .
SIBR GHGE Existing Existing Consume WA GHG adders NA

https://developer.caiso.com
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Fall 2023 — Energy Storage Enhancements Track 2

This initiative evolves processes and systems to help storage resource scheduling coordinators better manage resource
state of charge and continue to ensure efficient market outcomes. The purpose of this initiative is to enhance reliability tools
and the co-located model with regards to storage resources. The reliability enhancements include updates to bidding rules,

High Level - : . . . :
Business Problem exceptional dispatch of storage resources, storage resource opportunity costs, and local area minimum online constraints.
or Need The co-located model enhancements include preventing co-located resources from charging when beyond generation levels

for on-site resources and allowing pseudo-tied resources to use the co-located model. The scope of Track 1 covered the
enhancements for Summer 2023 Release. The remaining scope in the Energy Storage Enhancements Policy is covered in
Track 2 for Fall 2023 Release.

Reliability Enhancements
* Include lost opportunity from not generating in storage compensation due to hold Exceptional Dispatch (ED) to hold SOC
(i.e. 0 MW ED)

* Calculate counterfactual energy revenues with and without the SOC hold ED
+ If prices are below bids counterfactuals will not include discharges

* Use actual LMPs (the ISO will not generate counterfactual LMPS)

* Include SOC hold ED period through the end of the day in time horizon

High Level Project + Allow for Exceptional Dispatches (EDs) to be issued for storage resources to hold SOC
Scope  Develop functionality within ED User Interface; automate existing excel tool functionality
+ Storage may receive a traditional ED or an SOC ED, but not both
Co-Located Model Enhancements
» Develop an electable co-located model available to all storage resources
» Storage schedules to never exceed renewable schedules (i.e. no grid charging)
+ Storage may deviate down to match solar, when solar is producing less than schedules in real-time
+ Deviations to be subject to imbalance energy charges
* Require storage resources to submit outages when depleted and unable to charge
» Require all resources to respond to operator and ED instructions within physical bounds of operation
» Allow for co-located pseudo-tie resources to apply Aggregate Capability Constraint (ACC)
* Resources under an ACC must be pseudo-tied from the same BAA

BPM Changes Market Operations, Settlements & Billing

Impacted Systems Settlements, Market, CMRI, RIMS, MF, OASIS, ADS, OMS, ITS
\ T F \UHIVITIIU IV\N", Y YL

- T ———




Fall 2023 — Energy Storage Enhancements Track 2

Market » Allow operator to enter exceptional dispatch (ED) in the market to allow for EDs of storage resources by SOC in addition to
capacity
» Update the definition of EDs to allow the operator to enter EDs for storage resources identified with two new Reason Codes under
Instruction Type: System Emergency (“SYSEMR”)

ADS ADS consumes new ED Reason Codes (“SOC Hold” and “SOC Charge”) applicable to storage resources

Settlements * New rules to align with Tariff settlement language for SOC formula
* New inputs for the storage resource ED opportunity cost values
» Design and configure new charge code for the allocation of ED SOC uplift
» Modify real-time bid cost recovery (BCR) charge code to account for revenue from storage resources ED SOC uplift
» Configure No Pay rules and assessment for ED SOC

CMRI Receive and shall publish the ED SOC information using new Ul and API on a new report entitled “Exceptional Dispatch Hold State of
Charge”
OASIS Receive and publish new ED reason Codes (“SOC Hold” and “SOC Charge”) under System Emergency Instruction Type as “Reason”

on the Operator Initiated Commitment OASIS Report

RIMS » Add field for storage resource duration (hours)
* Add field for calculated MWh
» Calculate energy (MWh) using duration*MW
» Allow pseudo tied resources to be modeled as co-located

MF * Apply co-located flag to pseudo tied resources
« Set minimum ACC constraint to zero for co-located resources that cannot or choose not to not grid charge
* New MF attribute to denote resources that select to not grid charge

OMS Storage resources must submit outage cards if:
* The co-located VER cannot provide the charging energy as forecasted per Tariff requirements
» System shall require storage resources to submit outage cards if the resource has depleted its SOC and there is no ability to
charge the resource per Tariff requirements

ITS System shall model pseudo-tied and dynamic co-located storage resources following the standard NRI pseudo-tie and dynamic rules
and practices
Note: pseudo-tied and dynamic storage resources must be registered as TNGR resources
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Fall 2023 — Energy Storage Enhancements Track 2

Vilestone Type iestone Name

Obtain Board of Governors Approval

ST Dl WEIM Governing Board Approval B ey et
External BRS Post External BRS Yes
Settlements . .
First Draft Technical Documents Feb 17, 2023 v

Config Guides

Publish Interface Specification — ADS
Tech Spec Publish Interface Specification — CMRI Yes
Publish Interface Specification — OASIS

Tariff Tariff Activities Yes
BPMs Draft BPM changes — Market Operations Yes
Draft BPM changes — Market Settlements & Billing Yes
Market Sim Market Sim Window Yes
PI’O.dUC.tIOH Energy Storage Enhancements Track 2 Fall 2023 Release
Activation
&> California 1ISO ISO PUBLIC
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Fall 2023 — WEIM Resource Sufficiency Evaluation Enhancements Phase 2
Track 2

Project Information

+ Track-2
* Item2A — Clarification of Post-HASP Block Hour Low-Priority Export
» Operator-Driven Low-Priority Export Curtailment
» CAISO operator’s ability to initiate pro-rata curtailment based on identified MW, given the
following priority order:
« RTECON (RT economic hourly block export schedules that clear HASP).
* RTLPT (RT Self-Schedule hourly block export schedules not backed by
Generation from non-RA Capacity and cleared HASP).
High Level Project * Non-high-priority DA export [i.e. DAECON (DA economic hourly block export
Scope schedules that clear both RUC and HASP), or DALPT (DA hourly block export
schedules not backed by Generation from non-RA Capacity that also cleared both
RUC and HASP and are protected Self-Schedules)]
+ CAISO operator’s ability to identify/filter exports by market priority types as well as “Firm
Provisional Energy (G-FP)” eTag identifier.
» Publish resource-specific market priority types and their associated MW data to ADS.
* Item2B — Develop MF resource identification Capacity Test Failed-to-Start Rule Exemption flag to allow SCs of
WEIM and CISO short start units that start with non-positive telemetry to identify specific resources that will be
exempted from this functionality in RSE Capacity test. (Implemented in Phase 1 — enhancements needed)

BPM Changes WEIM, Market Instruments, Market Operations

Tariff Changes Yes

Impacted Systems MF, Market, ITS, ADS
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Fall 2023 — WEIM Resource Sufficiency Evaluation

Enhancements Phase 2 Track 2

MF .

ITS .

Market .

ADS .

Definition and Submission of Resource-Specific Capacity Test Failed-to-Start Rule Exemption Flag via
GRDT

Make Resource-Specific Capacity Test Failed-to-Start Rule Exemption flag accessible to downstream
systems.

Clarification of Post-HASP Block Hour Low-Priority Export

Consume DAM Resource-Specific Market Priority Types and Resource-specific RUC Energy Awards from
RUC.

Consume All Resource-Specific Market Priority Types from RTM.

SCs shall be required to submit Misc Info field Prior Type attribute for “Firm Provisional Energy (G-FP)” e-
tags to identify RTECON, DAECON, RTLPT, DALPT.

SCs shall be required to submit Misc Info field Prior Type attribute for “Firm Energy (G-F)” e-tags to identify
RTPT, DAPT.

Validate submitted export e-Tags against data received from RUC and RTM to approve/deny and adjust (if
warranted) the submitted e-Tags.

Access Resource-Specific Capacity Test Failed-to-Start Rule Exemption flag from MF.
Exempt Specific Resources from Capacity Test Failed-to-Start Rule/Functionality.
Clarification of Post-HASP Block Hour Low-Priority Export

Broadcast All Resource-specific market priority types to ITS (from RTM).

Clarification of Post-HASP Block Hour Low-Priority Export
« Consume Resource-Specific Market Priority Types and their Associated MW Data from RTM.
» Publish Resource-Specific Market Priority Types and their Associated MW Data.
* Include Resource-Specific Market Priority Types in ADS Query Functionality.
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Fall 2023 — WEIM Resource Sufficiency Evaluation
Enhancements Phase 2 Track 2

Milestone Type | Milestone Name

Obtain Board of Governors Approval

SN APIPTENE] WEIM Governing Board Approval PR Ep s
e 2o Post External BRS Mar 10, 2023 v
Post External BRS v1.1 Mar 31, 2023 v
Settlements
Config Guides NA NA
Tech Spec Create ISO Interface Spec (Tech spec) — MF RDT Yes
Tariff Tariff Yes
Draft BPM changes — WEIM
BPMs Draft BPM changes — Market Instruments Yes
Draft BPM changes — Market Operations
Market Sim Scenarios Market Sim Scenarios Yes
Market Sim Market Sim Window Yes

Production Activation =~ Resource Sufficiency Evaluation Enhancements Phase 2 Track 2 Fall 2023 Release
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Fall 2023 — WEIM Resource Sufficiency Evaluation Enhancements Phase 2
Track 3

Track-3
* Item3A — DR Inclusion with RSE via ALFS (RSEE-1060) (Implemented in Phase 1 — enhancements

High Level Project needed)

Scope * Furnish ALFS-SOA API integration to DR SCs to automatically submit their DR LF Adjustment
(that reflect Non-Participating DR Schedules) to account for DRs that are not explicitly modeled
in real-time markets.

BPM Changes Demand Response, WEIM

Tariff Changes NA

Impacted Systems MF, ALFS, Market, BAAOP
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Fall 2023 — WEIM Resource Sufficiency Evaluation
Enhancements Phase 2 Track 3

MF * RSEE-1060 — Business Process: Ensure DR Inclusion Flag Submission by WEIM Entity Only via CIDI.
RSEE-1060 — Business Process: STF Notification of Changes to DR Inclusion Flag on WEIM Entity / WEIM
Sub-Entity Level.

ALFS * Access DR Inclusion Flag on WEIM Entity/Sub-Entity Levels from MF.
« Translate the WEIM Entity/Sub-Entity DR Inclusion Flag to their associated LF zones (During MF transfer,
the sub-area LF zone will adopt the WEIM Entity attestation flag).
* Receive Non-Participating DR Schedules from WEIM Entity or WEIM Sub-Entity
* Broadcast Non-Participating DR Schedules for WEIM Entity BAA or WEIM Sub-Entity.
* Broadcast DR LF Adjustment Data (that have been adjusted in ALFS) to downstream systems.
Market » Consume the following from ALFS:

* ALFS-DF-Submitted DR LF Adjustment (hourly aggregate)
* STF-DF-Excluded DR LF Adjustment (hourly aggregate)
» Accounting for DR LF Adjustments in RSE.

BAAOP Display DR LF Adjustments received from ALFS in BAAOP.
Disable manual entry via BAAOP Ul on a sunset date, after all participants transition to ALFS API submission.
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Fall 2023 — WEIM Resource Sufficiency Evaluation
Enhancements Phase 2 Track 3

Milestone Type | Milestone Name

Obtain Board of Governors Approval

SN APIPTENE] WEIM Governing Board Approval PR Ep s
e 2o Post External BRS Mar 10, 2023 v
Post External BRS v1.1 Mar 31, 2023
Settlements
Config Guides g g
Tech Spec Create ISO Interface Spec (Tech spec) — ALFS Yes
Tariff Tariff NA
Draft BPM changes — Demand Response
SIS Draft BPM changes — WEIM W
Market Sim Scenarios Market Sim Scenarios Yes
Market Sim Market Sim Window Yes

Production Activation =~ Resource Sufficiency Evaluation Enhancements Phase 2 Track 3  Fall 2023 Release
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Fall 2023 — WA WEIM GHG Enhancements - Overview

Project ) Details/Date
Information

Pursuant to State of Washington'’s recently revised Clean Air Act and beginning in 2023, Washington (WA) will
require reporting of emissions associated with Western Energy Imbalance Market (WEIM) transactions.

; Emissions reporting is a key element of Washington’s new cap-and-invest program that sets a limit on overall
High Level carbon emissions in Washington and requires emitters to obtain allowances equal to their covered GHG

Business emissions.
Problem or Need o , : . . .
This initiative comprises the first phase of enhancements to support reporting WEIM transactions for emissions

year 2022. As reporting rules continue to develop, additional enhancements outside of the scope of this
initiative will likely be necessary.

Identify resources within WA State boundary
Update WA State associated resources’ greenhouse gas (GHG) reference levels with dynamic pricing using
vendor-provided indices
High Level * Note: while Tariff stipulates use of static pricing as an interim measure prior to the first Washington
Project Scope allowance auction, due to implementation timing, this is not anticipated to be necessary. This first
auction is scheduled for February 28, 2023.
» Calculate and publish monthly projected GHG prices for Washington State
» Develop reports to support WEIM Entity annual reporting to Washington State

BPM Changes Energy Imbalance Market (EIM), Market Instruments
Tariff Changes Sections 30.4.4.5,30.4.5.2,39.6.1.6.2,39.7.1.1.1.1,39.7.1.1.1.2,39.7.1.1.1.4

Impacted MF, Internal System, SIBR, OASIS
Systems
= % California I1SO 150 PUBHE
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Fall 2023 — WA WEIM GHG Enhancements - Overview

MF .

Internal
System

SIBR

OASIS

High Level Changes

New rule to verify that relevant resources within WA State must provide resource specified GHG emission
rate
New attribute at the BAA level to identify BAAs associated with Washington State
New attribute to associate resources within WA State with the State of WA to identify resources with GHG
obligation

*  Exception: BPA—not subject to WA reporting rule

Reference level (commitment costs/DEBS) changes to reflect GHG costs
* DEBs to include GHG components for generators inside WA State
* Update GHG startup cost curve for resources inside WA State
* Update Greenhouse Gas Minimum Load Cost Allowance
Differentiate between CA and WA resources
Capture WA GHG price in the resource-specific minimum load and startup GHG adders for the purposes of
commitment cost calculations

Receive startup GHG adders for the purposes of commitment cost calculations for WA State resources
Confirm GHG curves generated for WEIM resources within WA State are successfully received and processed

Add WA GHG index prices to existing GHG Index Price OASIS report
*  Only applicable for dynamic GHG pricing
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Fall 2023 — WA WEIM GHG Enhancements

Milestone
Type Milestone Name Dates Status

Board Approval Obtain Board of Governors Approval Oct 26, 2022

WEIM Governing Board Approval Oct 26, 2022 v
External BRS Publish External BRS Feb 06, 2023 v
SEUEGRE Settlements Config Guides NA

Config Guides

MFRDT
Tech Spec OASIS Yes
File Tariff ER23-474 Nov 21, 2022 v
i Tariff Accepted Feb 10, 2023 v
Filed Amendment Mar 13, 2023 v
Amendment Accepted Apr 20, 2023 v
Publish Draft BPM for Interim Solution — WEIM PRR 1506 Apr 26, 2023 v
Publish Draft BPM for Interim Solution — Market Instruments PRR 1507 Apr 26, 2023 v
BPMs
Publish Draft Business Practice Manuals Yes
Publish Draft Business Practice Manuals Yes
Market Sim Market Sim Window NA
Production Interim Solution May 01, 2023 v
Activation WA WEIM GHG Enhancements Fall 2023 Release
&> California 1ISO 1S PUBLIC



2023 — WA WEIM GHG Enhancements — Interim Solution

v Effective May 1, 2023, the CAISO has implemented an alternative interim
solution to activate functionality in the Washington WEIM GHG
Enhancements initiative.

* The alternative interim solution would allow SCs for resources in Washington
to reflect their GHG costs in the default energy bids and commitment costs.

« This effectively activates the tariff language for this initiative and the
alternative interim solution will remain in effect until it is replaced with the full
initiative implementation later this year. We don’t expect the interim solution
to delay the implementation of the full functionality.
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Independent 2023 Releases
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2023 - WEIM Enhancements 7

Project Information Details/Date

High Level Business To collectively address important issues identified by WEIM market participants through Customer Inquiry, Dispute and Information
Problem or Need system (CIDI) requests to improve the visibility, functions and features in Energy Imbalance Market (WEIM).

High Level Project * BAAOP: ETSR detail screen will be available to BOTH RTMO and WEIMs. (First drop for testing will only be available to RTMO).
Scope + BAAOP: WEIM shared ramping constraint IS NOT editable through Ul.

BPM Changes WEIM, Market Instruments

Tariff Change Section 29.4

Impacted Systems RTM/BAAOP, RTM/Integration

Real-Time Market BAAOP: ETSR detail screen May 2023

(RTM)

* ETSR detail screen will be available to BOTH RTMO and WEIMs. (First drop for testing will only be available to RTMO).
* New ETSR detail screens
* Currently in “Coming Soon”

Real-Time Market BAAOP: WEIM shared ramping constraint IS NOT editable through Ul. 2023
(RTM)
. Shared ramping capability constraint
. Ul for WEIM entity input parameters for ramp sharing
. Use in the optimization for each resource based on BAA ramp share parameters
£ California ISO ISO PUBLIC
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2023 — Hybrid Resources 2C RIMS

The ISO launched this stakeholder initiative to identify new or enhanced market rules and business processes
needed to accommodate hybrid resources, resources that consist of two sets of market rule changes that will
facilitate mixed-fuel type (hybrid and co-located resources) project participation in the ISO markets.

High Level Prior to this initiative, Phase 1 identified a first set of modifications generally concerned with setting up and
Business Problem operating co-located resources.
or Need

Building on phase 1, Phase 2 focuses on modifications that will explore how hybrid generation resources can be
registered and configured to operate within the ISO market. The initiative will further develop solutions allowing
developers to maximize the benefits of their resource’s configuration. Additionally, hybrid resource configurations
also raise new operational and forecasting challenges that the ISO plans to address during this initiative.

With this initiative, there’s an opportunity to increase storage and the number of hybrid resources that can connect
to the ISO grid. Currently the interconnection queue includes more than 24,000 MW of mixed fuel projects and
nearly 20,000 MW of storage which represents roughly half of all generation in the current interconnection queue.

High Level Project
Scope

BPM Changes Settlements & Billing

Summer 2023: Settlements
Impacted Systems Independent 2023: RIMS
Completed: Today’s Outlook, ISO Today Mobile Application, Reports

Requirements http://www.caiso.com/Documents/BusinessRequirementsSpecifications-HybridResourcesPhase?2.pdf
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http://www.caiso.com/Documents/BusinessRequirementsSpecifications-HybridResourcesPhase2.pdf

2023 — Hybrid Resources 2C RIMS

External BRS Publish External BRS Jan 31, 2023
Settlements
Config Guides MU NA
Tech Spec Create and Publish ISO Interface Spec (Tech Specs) NA
Market Sim Market Sim Window — RIMS NA
Production Activation Hybrid Resources 2C — RIMS 2023
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2023 — Application Delivery Resiliency

 Areas
— Access Policy Manager - Application Authentication
— Local Traffic Manager - Load Balancing

— Application Security Manager - Web Application
Firewall

« User Impacts & Actions
— New IP ranges requiring firewall changes

» Please open the entire 45.42.16.0/21 network
on ports 80 & 443 for our new IP space

— New URLs for Uls and APIs requiring cutover
— No application functionality changes expected
— No provisioning changes expected
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2023 — Application DeIivery Resiliency

SIBR Developer
remalnlng « BSAP + RCPortal
+ RCBSAP + GMS
«  BAAOP « CIDI
*  PlIVision
« DRRS - Fall 2020 Release
« ADS - Fall 2020 Release

« AIM
« CIRA
*  MRI-S

*  Public Website — May 26, 2021
. WWW.Caiso.com
. ISO Today Mobile Application
. Stakeholder Comments Tool
. content.caiso.com — July 29, 2022
. BPM - July 14, 2021
. WesternEIM - July 14, 2021
. Dev Site - July 2021
. RIMSPUB — September 14, 2021
. RIMS — September 14, 2021
. OASIS — Dec 2021 (No URL change)
. OMS - June 14, 2022

API All * ADS - Fall 2020 Release
*+ OASIS — Dec 2021 (No URL change)
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2023 — Application Delivery Resiliency

Remaining API Cutovers Plan

-  BAAOP - MAP-Stage and Production will have soft

- BSAP cutovers to have current and new APl URLs
. CIRA available in parallel for a window of time

- Current APl URLSs remain available while new

-  CMRI :

- DRRS API_ _URLs are introduced as they become
verified and ready for customer use

- EIDE - MAP-Stage new APl URLs will start to roll out in

- ALFS May 2023

- MF - Please open the entire 45.42.16.0/21 network

- PISOA on ports 80 & 443 for our new IP space to

- RCBSAP access new APl URLs

-  RCSERVICES (RCEIDE)

-  SIBR

- STLMT

- OMS
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2023 — Application Delivery Resiliency — MAPSTAGE

Plan

-  MAP-Stage new API URLs will start to roll out ~May 3, 2023

- Please open the entire 45.42.16.0/21 network on ports 80 & 443 for our
new IP space to access new APl URLs

Existing New
API MAPSTAGE MAPSTAGE
BAAOP https://wsmap.caiso.com/sst/baaop https://mapstage-ws.caiso.com/sst/baaop
BSAP https://wsmap.caiso.com/sst/bsap https://mapstage-ws.caiso.com/sst/bsap
CIRA https://wsmap.caiso.com/sst/cira https://mapstage-ws.caiso.com/sst/cira
CMRI https://wsmap.caiso.com/sst/cmri https://mapstage-ws.caiso.com/sst/cmri
DRRS https://wsmap.caiso.com/sst/drrs https://mapstage-ws.caiso.com/sst/drrs
EIDE https://wsmap.caiso.com/sst/eide https://mapstage-ws.caiso.com/sst/eide
ALFS https://wsmap.caiso.com/sst/runtime.asvc https://mapstage-ws.caiso.com/sst/runtime.asvc
MF https://wsmap.caiso.com/sst/runtime.asvc https://mapstage-ws.caiso.com/sst/runtime.asvc
PISOA https://wsmap.caiso.com/sst/runtime.asvc https://mapstage-ws.caiso.com/sst/runtime.asvc
RCBSAP https://wsmap.caiso.com/sst/rcbsap https://mapstage-ws.caiso.com/sst/rcbsap
RCSERVICES (RCEIDE) |https://wsmap.caiso.com/sst/rcservices https://mapstage-ws.caiso.com/sst/rcservices
SIBR https://wsmap.caiso.com/sst/sibr https://mapstage-ws.caiso.com/sst/sibr
STLMT https://wsmap.caiso.com/sst/stimt https://mapstage-ws.caiso.com/sst/stImt
oMS https://wsmap.caiso.com/sst/weboms https://mapstage-ws.caiso.com/sst/weboms
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Future Releases
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Future Releases Overview

Release Project BOG Tariff BRS Proc-iuct.lon
Activation
03/27/23: Draft Tariff
Transmission Service & Market Language
Scheduling Priorities Phase 2 Feb 2023 — Approved summer 2024
06/16/23: Revised DTL
Dec 2022 - July 2023 Draft Dec 2022 - July 2023 Draft
Day-Ahead Market Feb 2023 — Briefing business requirement business requirement Fall 2024
Future |Enhancements May 17, 2023 - Decision specification and tariff specification and tariff
Release development development
03/30/23: Draft Tariff
Extended Day-Ahead Market Feb 2023 — Approved Language Fall 2024
On-Boarding File Q2 2023 Spring 2025
&> California ISO ISO PUBLIC
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Congestion Revenue Rights (CRR) Upgrade

The Congestion Revenue Rights (CRR) system was implemented by CAISO in 2008 as part of the Market Redesign and
Technology Upgrade (MRTU) implementation. The current CRR system is at its end of life, does not have the flexibility to
accommodate future policy changes and requires the ISO to calculate data and run processes manually outside the current
system to produce a successful CRR Auction.

The CAISO has decided on a significant upgrade of the existing CRR system and adopt the latest technology stack aligned with
CAISO'’s technology standards, consolidate all CRR related functions, minimize human errors, reduce processing time, eliminate
manual workarounds, and positions the system to accommodate policy changes down the road.

High Level Project Congestion Revenue Rights (CRR) system replacement project scope is the roll-out of a:
Scope + Brand new user-interface (Ul) system with an updated new look-and-feel, to replace the existing legacy system implemented
during the MRTU 2008 go-live and brought up to current ISO technology standards
+ Set of application-programming interfaces (APIS) to enable integration between 1SO and market participant systems

Overall, to support the following in one consolidated CRR external-facing system:

* Annual/Monthly Auction and Allocation market participant bid submission and results retrieval
* Load data submission by CRR LSEs, CEC

» Load migration data submission by CRR UDCs

» Secured "Congestion Revenue Rights Full Network Model" information access

» Private and public access of CRR market input and output information

Congestion Revenue Rights
* Enhancements made to the new CRR product.
» Automatic publishing of CRR market results.
+ Automatic CRR noatification.
BPM Changes * New CRR schedule calendar.
* New CRR FNM access.
* New CRR data submission and download interface UI/API.
* New CRR market results interface.
* Load Migration

Tariff Change No
Impacted Systems CRR, AIM, CMRI, OASIS, CTS, Market Clearing, EMMS, IFM/RTN, MQS, Master File, MPP, Settlements, WebOMS, ETCC.
Y - .
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Congestion Revenue Rights (CRR) Upgrade

CRR Significant system upgrade including:
* Enhancements made to the new CRR application.
» Automatic publishing of CRR market results.
» Automatic CRR noatification.
* New CRR schedule calendar.
* New CRR FNM access.
* New CRR data submission and download interface UI/API.
» Other TBDs identified through BRS development.

AIM * New users and roles to support new CRR functionality

CMRI » Full and incremental Payload publishing
» Publish CRR Awards payload on event-driven, ad-hoc or scheduled basis
» Publish CRR Awards payload on event-driven, ad-hoc or scheduled basis

OASIS » Publish CRR Calendar, and all available CRR market names, and credit margin information, 3 year historical expected value..
» Allow authorized users to publish CRR inventory payloads
» Broadcast the following: set aside values, the results of all CRR markets, retired pnode/anode mapping, binding constraints, initial and
updated CRR source and sink list for each CRR market,

CTS + Broadcast

EMMS * CRR will consume data from EMMS

IFM/RTN * CRR will consume data from IFM/RTN

MQS * MQS will consume and process SCID in a new format

*  MQS will consume ownership payload in bulk

Master File » Master File will be modified as needed to support the new CRR functionality
MPP * CRR will provide pre-configured external reports
Settlement + Settlements will be modified as needed to support the new CRR functionality
WebOMS * CRR will consume data from WebOMS
ETCC * CRR will consume data from ETCC
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Congestion Revenue Rights (CRR) Upgrade

Milestone Type Milestone Name

Board Approval Obtain Board of Governors Approval NA

External BRS Publish E?<t_ernal BRS Nov 16, 2022 v
BRS Revision v1.3 Mar 29, 2023 v

Config Guides Post Draft Config Guides Yes

Tech Spec Publish Technical Specification Feb 24, 2023 v

Deployment Plan Draft Deployment Plan Yes

Training Training Yes

Market Sim Market Sim Yes

Parallel Operations Parallel Operations Yes

Customer Partnership Next CPG May 31, 2023

Group
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CRR System Upgrade — Get Connected

 CRR meetings:

— Bi-weekly Technical User Group (TUG) Tue 10 AM, alternates with RUG.
« Meetings available on the CAISO calendar on www.caiso.com

* Meeting details and presentation materials are available on the CAISO
Developer site at www.developer.caiso.com , which requires an
account to be setup for access

— CRR Customer Partnership Group
* Next CPG meeting is Wed, 5/31 @ 10 AM
« Monthly
» Meetings available on the CAISO calendar on www.caiso.com

» Meeting details and presentation materials are available on
Www.caiso.com > Stay Informed > Meetings & Events > Customer
Partnership Groups
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Stay Informed
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Ways to participate in releases

* Visit the Release Planning page
— http://www.caiso.com/informed/Pages/ReleasePlanning/Default.aspx

« Attend meetings
— Release Users Group (RUG) bi-weekly meetings
* Initiative status updates
« System change updates on independent releases

— Market Simulation calls

+ Visit the ISO calendar at www.caiso.com for meeting dates and times and
add events to your calendar

« Typically held on Mondays and Thursdays

— Market Performance and Planning Forum
* Bi-monthly review of market performance issues

» High level discussion of release planning, implementation and new market
enhancements

&> California ISO SO PUBLIC
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What to look for on the calendar...

Calendar of Meetings, Training and Events
WMonth[February [w] Year:[2018[w] | caencarview [Letview | prmt view |

I

Sun

pday

Market Sim

Release Users Group
(RUG)
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Next RUG: May 16, 2023

Contact for Questions & Agenda Requests: Trang Vo, tvo@caiso.com

Stay connected

v Z 2

@California_1SO Download 1SO Sign up for the I_Daily Briefing
at www.caiso.com
Today
mobile app
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RUG Calendar 2023

"ﬁ?ﬂ California ISO
2023

Release User Group Meetings

Nofe: dates subject to change; for the late st information please visit the Calendar on www.caiso.com
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’ Follow us on Twitter @California_ISO for our latest updates
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